Microsoft Excel 2013™
Hints & Tips (Level 3)

Contents

Introduction .................................................................1
Starting Excel and Customising the Screen .........................1
Further Key Combinations ..............................................2
  Further Function Keys & Key Combinations .....................3
Data Entry and Cell Formatting ......................................3
Moving Around and Selecting Cells ................................3
Making Good Use of the Mouse ......................................4
  Moving/Copying Data and Filling a Series .....................4
  Other Useful Mouse Tips ...........................................4
Screen Layout .............................................................5
  Using Colours and Adding Comments ...........................5
Cell Referencing ........................................................8
Charts .................................................................8
Printing Tips .............................................................8
Other Tips .....................................................................8

Introduction

The aim of this document is to show you how to make the best use of some of the facilities in Microsoft Excel and, in particular, to save you time when using it.

Note that this document doesn’t include tips applicable throughout the Microsoft Office suite – see the document Microsoft Office 2013 – Hints & Tips for details of these. The Office tips include starting a program and opening files, customising the Ribbon and Quick Access Toolbar, issuing commands from the keyboard, AutoText, quick methods to select text, and when to use the mouse button rather than the keyboard.

Be aware that we have several other documents on using Excel, including An Essential Guide, An Intermediate Guide, plus a host of Advanced Topics.

Starting Excel and Customising the Screen

Begin by launching Excel, as usual:

1. Open the Start menu, choose All Programs then Microsoft Office 2013 and Excel 2013
Note: Launching Excel via the **Start** menu isn’t the most efficient way of doing things; it’s much easier to do so from an icon on the **Desktop** or **Taskbar**, as described in the *Microsoft Office 2013 – Hints & Tips* notes.

Immediately above the **[Start]** button is the **Status Bar**. In Excel 2013, you are now shown a wider range of statistics when you select a range of cells. To customise the settings:

1. Right click on the **Status Bar** – the **Customize Status Bar** pop-up menu appears
2. Turn on/off the elements required

Throughout Office 2013, the tabs on the **Ribbon** and **Quick Access Toolbar** can now be customised. How you do this is covered in the *Microsoft Office 2013 Hints & Tips* notes. Another tab, the **Developer** tab, is hidden by default. This is a useful addition if you create macros. To display this tab:

4. Move to the **FILE** tab then click on **Options** at the foot
5. Note the options available under the When creating new workbooks heading
6. Under **Customize Ribbon**, turn on **Developer** in the pane on the right – press **<Enter>** for [OK]

There are lots of other options you might like to set, some of which (eg **AutoCorrect**) are covered in the *Microsoft Office 2013 Hints & Tips* notes. It’s worth looking through the options when you have time, in case there is anything you would like to change (eg the default file format and save location).

Another screen customisation you might like to set is the **Zoom** level. Individual spreadsheets can have their own **Zoom** setting, which are retained when the workbook is saved. To change the zoom level:

7. Click on the **[Zoom level]** button (currently showing as 100%) in the bottom right of the screen
8. The **Zoom** dialog box appears, in which you can set the zoom level required - press **<Enter>** for [OK]

To the left of **[Zoom level]** are the different **View** layouts. Some people like working in **[Page Layout]** view.

Accompanying these notes is an example file, containing all the instructions needed to carry out the exercises. For those

1. Press **<Ctrl o>** for **[Open]** then click on **Computer**
2. An **Open** window appears – click on **My Computer** then **double click** on **Data (D:)** to **[Open]** it
3. **Double click** on the folder called **Training** to open it
4. Click on **hints&tips.xlsx** from the list which appears and press **<Enter>** or click on [Open]

Note: For those using these notes on a computer not run by IT Services, the example file can be downloaded from the link provided at step 4 above. The data does not refer to real people.

Users are welcome to take a copy of the example file if they want to practice.

---

**Further Key Combinations**

Having to issue commands using the mouse and icons on the **Ribbon** (or via the right mouse button) can be very inefficient. This is especially true in Office 2010, where you may need to switch tabs on the **Ribbon** before you can access a command. Make good use of key combinations to issue commands instead. The commoner commands are covered in the document *Microsoft Office 2013 Hints & Tips*; here are some Excel-specific ones:

- **<Ctrl ;>** - Insert Today's Date
- **<Ctrl :>** - Insert Current Time
- **<Ctrl a>** - Display palette when entering function
- **<Ctrl d>** - Fill down
- **<Ctrl r>** - Fill right
- **<Shift spacebar>** - Select row
- **<Ctrl spacebar>** - Select column
- **<Ctrl 9 or 0>** - Hide rows or columns
- **<Ctrl Shift 9 or 0>** - Unhide rows or columns
- **<Ctrl 1>** - Display **Format Cells** dialog box
- **<Ctrl Shift f for p>** - Displays **Format Cells Font** tab
- **<Ctrl | or >** - Direct precedents or dependents
- **<Ctrl +>** - Show **Insert** dialog box
- **<Alt = >** - Apply **SUM** function
- **<Ctrl - >** - Show **Delete** dialog box
- **<Ctrl ^ >** - Show/hide formulas
Further Function Keys & Key Combinations

The simple use of function keys to issue commands is also covered in the document *Microsoft Office 2013 Hints & Tips*; here are a few more, Excel-specific ones:

- `<F2>` - Edit mode
- `<Shift F2>` - Edit comment
- `<Shift F11>` - Insert new worksheet
- `<Shift F3>` - Insert function
- `<F4>` - Repeat last command or Create absolute reference
- `<F8>` - Turn extend mode on/off
- `<Alt F8>` - Select non-adjacent cell or range using arrow keys
- `<F11>` - Create chart on new Chart sheet
- `<Alt F1>` - Create chart on current sheet

The most important key combinations here are `<F2>` and `<F4>`. These were also covered in the *Microsoft Excel Essential* and *Intermediate* notes. Note that if you aren’t in *Edit Mode* (editing or entering a formula) and use `<F4>`, then it repeats the previous command.

Data Entry and Cell Formatting

There are a few tricks to follow when entering data or formulae into cells. Excel automatically applies a data type and format as you type in information. You should be aware that:

- Using a slash or hyphen (minus sign) between numbers gives a *date* format
- Using a colon between numbers gives a *time* format
- Preceding a number with a currency symbol (£, $ or €) gives a *currency* format
- Including a comma in a number (eg 1,500) gives a *comma* format
- Having a percentage sign (%) at the end of a number gives a *percent* format
- For a *fraction* format, precede the fraction with 0 (or number) then a space and the fraction (eg 0 1/3)
- Preceding a number with a single quote (’) forces it to be stored as *text*

Note also that data stored as text appears left-justified in a cell (by default); data stored as a number appears right-justified; a *Boolean* (TRUE or FALSE) appears centred. *Dates and times* are in fact stored as numbers (the number of days since the start of the last century - ie 12 noon on 3 Jan 1900 is stored as the number 3.5) but an appropriate display format converts this into the date/time.

Cell formatting can be applied using the following key combinations:

- `<Ctrl ~>` - Apply General Number format
- `<Ctrl !>` - Apply Number format with 2 dec places
- `<Ctrl ^>` - Apply Exponential Number format
- `<Ctrl #>` - Apply Date format
- `<Ctrl @>` - Apply Time format
- `<Ctrl $>` - Apply Currency format
- `<Ctrl %>` - Apply Percentage format

Moving Around and Selecting Cells

It’s much quicker to use the keyboard rather than the mouse to move around your cells (and select them). Only through practice will you learn which method is the best for you (and in which circumstances). The following were covered in the *Essential* and *Intermediate* notes and are repeated here for convenience:

- Use `<Tab>` and `<Shift Tab>` to jump across/back cells in a row
- Use `<Enter>` and `<Shift Enter>` to move down/up a column
- Use `<Ctrl Enter>` to preserve the position of the current cell
- Use `<Ctrl Home>`/`<Ctrl End>` to move to the start/end of the data
- Use `<Ctrl left/right arrow>` (or `<End>` then `<l/r arrow>`) to move to the start/end of a block
- Use `<Ctrl up/down arrow>` (or `<End>` then `<u/d arrow>`) to move to the top/bottom of a block
- Use `<Home>` to move to column A
- Use `<PageUp>` and `<PageDown>` instead of the scroll bar to move up and down worksheets
- Use `<Alt PageDown>` and `<Alt PageUp>` to move a screen width across/back the worksheet
- Use `<Ctrl PageDown>` and `<Ctrl PageUp>` to move to the next/previous worksheet

Using key combinations to select data is even more important – you can lose control using the mouse. The following were covered in the Intermediate notes. If you don’t already know them, try them out here:

- Make use of the `<Shift>` key to select cells; use `<Shift>` and arrow keys to extend/reduce a selection
- Use `<Ctrl Shift>` and `<left/right arrow>` to extend a selection to the end/start of a line
- Use `<Ctrl Shift>` and `<up/down arrow>` to extend a selection to the top/bottom of a column
- Use `<Ctrl Shift End>` or `<Home>` to extend a selection to the end or start of the sheet
- `<Ctrl a>` or `<Ctrl *>` selects the current region (delimited by an empty column and row)
- Avoid clicking on row/column headings (to select whole rows/columns) or dragging through the headings (to select several rows/columns) unless this is specifically required

Making Good Use of the Mouse

Sometimes it’s the mouse that offers the quick and easy way to do something.

Moving/Copying Data and Filling a Series

The mouse is particularly useful when moving or copying cells and when dealing with data series.

- Hold down the mouse on the cell/range border to drag it/them to another location
- Holding down `<Ctrl>` when dragging copies the cell contents (instead of just moving it)
- Dragging with the right mouse button gives further options when moving/copying
- Drag using the cell/range handle to copy a value, fill a series or copy formulae
- Dragging with the right mouse button on a handle gives further options when copying/filling
- Double click on a cell/range handle to fill down a column (with a formula, value or series)

**Note:** The fill options are displayed automatically if you use the right mouse button when you drag out a value (or formula).

Other Useful Mouse Tips

Here are some other useful mouse tips:

- Instead of typing in cell references in formulae, click on the cells (or drag through a range)
- Hold down `<Shift>` and click to select a region (starting from the current cell)
- Hold down `<Ctrl>` and click or drag to select non-adjacent cells or ranges
- Right click on a cell to display a shortcut menu
- Double click inside a cell to edit it directly (instead of on the Formula Bar or using `<F2>`)
- Double click on a cell border to move left/right/up/down (same as `<Ctrl arrow>`)**
- Click the mouse wheel then use the mouse to scroll left/right and up/down (click to turn off)
- Hold down `<Ctrl>` and rotate the mouse wheel to zoom in/out
- Rotate the mouse wheel with the cursor on the Ribbon to move across the tabs

Try out the above if you don't already know them and think they might be useful.
Screen Layout

There are various things you can do to the screen layout, which can make it easier to use Excel:

- Data can be justified vertically as well as horizontally in a cell
- The [Wrap Text] button allows text to wrap around on several lines within a cell
- Double click on a column (or row) heading border to fit the column to the data
- Drag on the column (or row) heading border to show the actual width (height)
- Avoid empty rows or columns (unless you are creating different data regions)
- To separate row/column headings from data, simply increase row height or column width
- Use [Freeze Panes], on the View tab, to permanently display row and/or column headings
- Use [Split], on the View tab, to see different sections of a worksheet at the same time
- [Zoom] to a higher / lower magnification if you want to see less / more cells.

Using Colours and Adding Comments

One of the easiest ways to improve the look of a spreadsheet is to make full use of colour - both for text and cell backgrounds. Sometimes colour is used just for cosmetic reasons but it can also be used to give a visual warning if something goes wrong.

- Colour code cells which contain certain types of data or which need further investigation
- Use conditional formatting to apply certain formats automatically (eg the colour fill)
- Add comments to cells to explain what is being calculated or what needs to be done
- If you want to hide some text on a sheet, change the font colour to white
- When using multiple sheets, colour code each sheet (and also name it suitably)

Tip: Once cells have been coloured, they can be sorted or filtered by colour. You can also use conditional formatting to add colour scales, data bars or icon sets to your cells.

Comments can be permanently displayed or hidden (a red triangle in the top right corner indicates that a cell has a comment) and can also be printed out if required.

Cell Referencing

When you enter a cell reference in a formula in Excel, it is not fixed by default. This means that the reference can change if the formula is copied and pasted to another cell (or if it is dragged out across a range of cells). Sometimes, you need to fix a cell reference so that it doesn’t change. This can be done by naming the cell (or range of cells) or adding a $ before the column letter and/or row number to create an absolute reference.

- A colon between two cell references indicates a range (ie all cells between the two references)
- To reference a whole row/column, repeat the row number or column letter - eg A:A or 3:3
- Several rows/columns can similarly be referenced - eg 1:50 or C:E
- A comma can be used to separate cell references in a formula - eg SUM(A2,A5:A8,A10)
- To reference cells on another sheet, separate the sheet name from the cells with an exclamation mark
- To fix any part of the cell reference, use the $ notation - eg $A$5 or $A5 or A$5
- Use <F4> when entering a formula to add the required $ notation to a cell reference
- To create named ranges from column/row headings, press <Ctrl Shift F3>
- In a macro, it’s usually best to use relative references, not absolute references
- Be aware of R1C1 referencing (FILE … Options … Formulas) – especially useful with macros
Charts

There isn’t time to cover Excel charts in detail in this course. Here are just a few tips, which should be of interest:

- It’s a good idea to create them on separate Chart sheets (unless you need to see the data too)
- To move a chart to a different or new sheet use [Move Chart] from the Chart Tools Design tab
- Use an X-Y graph if you want the data plotted along the horizontal axis (as well as vertical)
- Charts can have two vertical y-axes - double click on a data series and go to the Axis tab
- To create a chart quickly, select the data then press <F11> or <Alt F1>
- You can Copy data and Paste it directly to a chart - Paste Special gives further options
- You can create your own customised chart types (like a template)

Printing Tips

Excel provides various additional printing features (compared to other Microsoft Office applications), which you should be aware of:

- You can define the area to be printed using [Print Area] on the PAGE LAYOUT tab
- You can zoom the print area in or out using [Scale] on the PAGE LAYOUT tab
- The [Width] and [Height] buttons let you fit your data onto an exact number of pages
- Via the [Margins] button you can centre the output horizontally and/or vertically
- The [Print Titles] button lets you set column (or row) headings at the top (or left) of each page
- If you use [Page Break Preview] (on the VIEW tab) you can adjust where page breaks occur by dragging them with the mouse - this also resets the Print Area
- Hide (right click) any rows/columns in the print area which you do not wish printed out

Other Tips

Finally, here are a few more useful tips:

- Use [Arrange All] on the VIEW tab to see two open worksheets side by side (these could either be from different files or the same one)
- To add text to a formula, type it in double quotes and separate it from the calculation by &
- Use [Merge and Center] on the HOME tab to centre a title over several columns
- Using the [Orientation] button, text in a cell can be rotated to any angle between +90° and -90°
- If you have more than one data value in a cell, the [Text to Columns] button on the DATA tab can be used to separate the values into several columns
- You can create your own series (move to the FILE tab, click on Options then on Advanced; scroll down to the end then click on Edit Custom Lists… in the General group). With these series you only have to type one value to generate the others. You can also sort data based on a series
- Don’t forget that you can hide rows/columns/sheets - eg to hide background calculations
- Another way to hide calculations is to move them onto a separate sheet (which could be hidden) then just display the results on the main sheet
- You can also hide data/formulae by setting the font colour to match the cell background (eg white)
- Be aware of the numerous functions that are available
- When using an unfamiliar or complex function, use the [Insert Function] button to help guide you
End the session by closing down Excel:

1. If you want to save the changes to this file, press <Ctrl s> for [Save]
2. Now press <Alt F4> (or <Ctrl F4> if you want to close this file and leave Excel running)

If you have completely finished using the computer, a quick way to log off is to:

3. Press the <Windows> key (between <Ctrl> and <Alt>)
4. Press <right_arrow> (for Log Off)
5. Press <Enter> again to confirm this